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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and TrueType are trademarks of Apple Computer,
Inc, registered in the U.S. and other countries.

BonjourTM is a trademark of Apple Computer, Inc.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

❖ Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner or print cartridge, and other consumables.

❖ Security Reference
This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use. Also refer to this manual for the
procedures for registering administrators, as well as setting user and admin-
istrator authentication.

❖ Copy/Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.

❖ Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

❖ Facsimile Reference
Explains Facsimile functions and operations.

❖ Printer Reference
Explains Printer functions and operations.

❖ Scanner Reference
Explains Scanner functions and operations.
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❖ Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.

❖ Other manuals
• Manuals for This Machine
•  Safety Information
• Quick Reference Copy Guide
•  Quick Reference Fax Guide
• Quick Reference Printer Guide
• Quick Reference Scanner Guide
• PostScript 3 Supplement
• UNIX Supplement
• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide
• DeskTopBinder Introduction Guide
• Auto Document Link Guide

Note
❒ Manuals provided are specific to machine types.
❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the

manuals as PDF files.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.
[ ]
Indicates the names of keys that appear on the machine’s display panel.
{ }
Indicates the names of keys on the machine’s control panel.
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Using the DeskTop Binder-
SmartDeviceMonitor for Client Port

Installing DeskTop Binder-SmartDeviceMonitor for Client

Important
❒ To install DeskTop Binder-SmartDeviceMonitor for Client under Windows

2000 / XP Professional, Windows Server 2003, and Windows NT 4.0, you
must have an account that has Manage Printers permission. Log on as an Ad-
ministrator.

❒ Install DeskTop Binder-SmartDeviceMonitor for Client before installing the print-
er driver when using the DeskTop Binder-SmartDeviceMonitor for Client port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [DeskTopBinder - SmartDeviceMonitor for Client].

E The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [I accept the agreement.], and
then click [Next >].

F Click the [DeskTopBinder - SmartDeviceMonitor for Client] checkbox, and then
click [Next >].
The DeskTop Binder-SmartDeviceMonitor for Client installer starts.

G Follow the instructions on the display to install DeskTop Binder-SmartDe-
viceMonitor for Client. 

H Click [Finish].
If you are required to restart the computer after installing DeskTop Binder-
SmartDeviceMonitor for Client, restart the computer.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - 
TCP/IP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default. 

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

M On the [Details] tab, click [Add Port…].

N Click [DeskTop Binder-SmartDeviceMonitor] in the [Other] list, and then click
[OK].

O Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.



Using the DeskTop Binder-SmartDeviceMonitor for Client Port

5

1

P Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], enter the IP address or host
name of the machine, and then click [OK].
You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used. 

Q Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

R Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - IPP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default. 
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J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

M On the [Details] tab, click [Add Port…].

N Click [DeskTop Binder-SmartDeviceMonitor] in the [Other] list, and then click
[OK].

O Click [IPP].

P In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL ( a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

Q Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

R Click [Detailed Settings] to configure proxy server, IPP user name, and other
settings. Make these settings, and then click [OK].
You can enter "http://printer's address/ipp" as the printer's address.

S Click [OK].

T Check that the selected port is highlighted in [Print to the following port], and
then click [OK] .

U Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

K Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Specify whether or not to share the printer, and then click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.
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Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.
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K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

L Click [Detailed Settings] to configure proxy server, the IPP user name and oth-
er settings. Specify the necessary settings, and then click [OK]. 
For information about the settings, see DeskTop Binder-SmartDeviceMonitor
for Client Help.

M Click [OK].

N Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

O Change the printer name if you want, and then click [Next >].

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

K Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default. 

M Specify whether or not to print a test page, and then click [Next >].

N Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe”on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.
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L Click [Detailed Settings] to make necessary settings.
For information about the settings, see DeskTop Binder-SmartDeviceMonitor
for Client Help.

M Click [OK].

N Check that the name of the printer driver you want to install is selected, and
then click [Next >].

O Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].

F Click [Add Port...].

G Click [DeskTop Binder-SmartDeviceMonitor], and then click [New Port...].
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H Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

I Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

J Click [Close] to close the [Printer Port] dialog box.

K Click [Next >].

L Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

N Specify whether or not to share the printer, and then click [Next >].

O Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

P Restart the computer to complete installation if necessary.

Note
❒ A user code can be set after the printer driver installation . For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].

F Click [Add Port...].

G Click [DeskTop Binder-SmartDeviceMonitor], and then click [New Port...].

H Click [IPP].

I In the [Printer URL] box, enter “http://(printer's address)/printer”as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

J Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

K Click [Detailed Settings] to make necessary settings.
For information about the settings, see DeskTop Binder-SmartDeviceMonitor
for Client Help.
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L Click [OK].

M Click [Close] to close the [Printer Port] dialog box.

N Click [Next >].

O Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

P Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

Q Specify whether or not to share the printer, and then click [Next >].

R Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

S Restart the computer to complete installation if necessary.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Changing the Port Settings for DeskTop Binder-
SmartDeviceMonitor for Client

Follow the procedure below to change the DeskTop Binder-SmartDeviceMonitor for
Client settings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

A Open the [Printers] window from the [Start] menu.

B  In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C  Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
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Windows 2000 / Windows NT 4.0:

A Open the [Printers] window from the [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port] 
The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003: 

A Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C  Click the [Port] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
• For TCP/IP, timeout setting can be configured.
• User, proxy, and timeout settings can be configured for IPP.

Reference
For information about these settings, see DeskTop Binder-SmartDevice-
Monitor for Client Help.

How to enable Recovery/Parallel Printing

If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

A Start DeskTop Binder-SmartDeviceMonitor for Client, and then right-click
the DeskTop Binder-SmartDeviceMonitor for Client icon on the taskbar.

B Click [Extended Features Settings], and then select the [Set Recovery/Parallel
Printing for each port] check box.

C Click [OK] to close the [Extended Features Settings] dialog box
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Using the Standard TCP/IP Port

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

DeskTop Binder-SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IP address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

K Click [Next >]

L Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].



Windows Configuration

18

1

N Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

O Click [Next >].

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation . For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

DeskTop Binder-SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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J Enter the printer name or IP address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

K Click [Next >]

L Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

N Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

O Specify whether or not to print a test page, and then click [Next >].

P Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port], and then click [Next >].

I Enter the printer's IP address in the [Name or address of server providing lpd] box.

J Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].

K Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the LPR Port. Use the DeskTop Bind-

er-SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].

F Click [Local Printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port] in [Create a new port], and then click [Next >].

I Enter the printer's IP address in the [Name or address of server providing lpd] box.

J Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].

K Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory."
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].

F Click [Add Port...].

G Select [LPR Port], and then click [New Port...].

H Enter the printer's IP address in the [Name or address of server providing lpd] box.

I Enter “lp” in the [Name of printer or print queue on that server:] box, and then click [OK].

J Click [Close] to close the [Printer Port] dialog box.

K Click [Next >].

L Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

N Specify whether or not to share the printer, and then click [Next >].

O Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

P Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me)

Important
❒ If you print from a print server connected to the printer using the DeskTop

Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network printer], and then click [Next >].

G Click [Browse].

H Click the computer name you want to use as a print server in the [Browse for
Printer] window.

I Select the printer you want to use, and then click [OK].

J Check the location of the selected printer is shown, and then click [Next >].

K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

M Restart the computer.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒  Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the DeskTop

Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network printer], and then click [Next >].

G Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the DeskTop

Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

❒ If you print with a Windows XP or Windows Server 2003 print server, Desk-
Top Binder-SmartDeviceMonitor notification functions may not be possible
for the client.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [A network printer, or a printer attached to another computer] and then click [Next >].

G Select [Browse for a printer], and then click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the DeskTop

Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

❒ To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Network printer server], and then click [Next >].

F Click [Next >].

G Double-click the computer name you want to use as a print server in the
[Shared printers] window.

H Select the printer you want to use, and then click [Next >].

I Check the location of the selected printer is shown, and then click [Next >].

J Change the printer name if you want, and then click [Next >].

K Specify whether or not to print a test page, and then click [Finish].
Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Using as the NetWare Print Server / Remote 
Printer

When using the PostScript 3 Printer Driver

Important
❒ In an IPv6 environment, Netware servers cannot be used.
Follow the procedure below to set up the PostScript 3 printer driver.

A In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.
When using Windows 2000 / XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.

C Click [Advanced].

D Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

E Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Important
❒ Make sure that machine is connected to the computer's USB ports using the

USB interface cable.
Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.
The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

Windows 98 SE / Me - USB

Important
❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-

dows 98 SE / Me.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

A Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
The plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the op-
erating system.

D Click [Next >].

E Click [Search for the best driver for your device. {Recommended}.], and then click [Next >].

F Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

G Insert the CD-ROM into the CD-ROM drive.

H Specify the location where USB Printing Support is located, and then click [Next >].
If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:
D:\DRIVERS\RPCS\WIN9X_ME

I Check the location, and then click [Next >].
USB Printing Support is installed.
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J Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

K Click [Next >].

L Click [Search for the best driver for your device. {Recommended}.], and then click [Next >].

M Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

N Insert the CD-ROM into the CD-ROM drive.

O Specify the location where the source files of the printer driver is stored,
and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3

D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1

P Check the location, and then click [Next >].
Add Printer Wizard starts.

Q Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

❒ The number after "USB" varies depending on the number of printers con-
nected.

❒ It is not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.

❒ Install the printer driver from the CD-ROM provided with the printer.
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Windows 2000 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Check that the power of the printer is off.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

D Click [Next >] in the [Found New Hardware Wizard] dialog box.

E Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next >].

F Select the [Specify location] check box, and then click [Next >].

G Insert the CD-ROM into the CD-ROM drive.

H Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

I Check the printer driver location, and then click [OK].

J Click [Next >].

K Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

❒ The number after “USB” varies depending on the number of printers con-
nected.
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Windows XP, Windows Server 2003 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
The printer drivers can be installed from the CD-ROM provided with this ma-
chine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Turn off the power of the machine.

B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next >].

E To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

F Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

G Check the printer driver location, and then click [Next >].

H Click [Continue].

I Click [Finish].
If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

Note
❒ If Auto Run starts, click [Cancel], and then [Exit].
❒ The number after “USB” varies depending on the number of printers con-

nected.
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Troubleshooting for using USB

Problems Solutions

The machine is not automatically rec-
ognized.

Turn off the power of the machine, reconnect the USB 
cable, and then turn it on again.

Windows has already configured the 
USB settings.

Open Windows' Device Manager, and then, under [Uni-
versal Serial Bus controllers], remove any conflicting de-
vices. Conflicting devices have a yellow [!] or [?] icon by 
them. Take care not to accidentally remove required de-
vices. For details, see Windows Help.

Note
❒ When using Windows 2000 / XP or Windows Server 

2003, an erroneous device is displayed under [USB 
Controller] in the [Device Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose printer driver you want to install,
and then click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 printer driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].

H Select whether or not to share the printer, and then click [Next >].

I Select the name of the machine whose driver you want to install, and then
click [Next >].

J Select whether or not you want to print a test page, and then click [Finish].
The printer driver installation starts.

K Restart the computer to complete installation if necessary.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

H Select the name of the machine whose driver you want to install, and then
click [Next >].

I Click [Close] to close the [Printer Port] dialog box.

J Click [Next >].

K Change the printer name if you want, and then click [Next >].

L Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

M Restart the computer to complete installation.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].

F Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

I Specify whether or not to share the printer, and then click [Next >].

J Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

K Restart the computer to complete installation if necessary.

Note
❒ A user code can be set after the printer driver installation. For information

about user code, see the printer driver Help.
❒ Auto Run may not work with certain operating system settings. In that

case, launch “Setup.exe” on the CD-ROM root directory.



Installing the Printer Driver Using IEEE 1394 (SCSI print)

37

1

Installing the Printer Driver Using IEEE 1394 
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this ma-
chine. 

Important
❒ Quit all applications currently running, and do not print during installation.
❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another

printers during installation.
❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable

is disconnected from the computer.
❒ SCSI print must be set to "active" from the control panel. For details, see Net-

work Guide.
❒ This machine can receive print data from one computer at a time only. An

message may appear if jobs from different computers collide.
❒ If jobs collide, the first received is printed first.
❒ When the printer driver is properly installed, connecting or disconnecting the

optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or

higher.

A Connect the machine and computer using the IEEE 1394 interface cable.

B Click [Next >] in the [Found New Hardware Wizard] dialog box.

CWhen the message "This wizard will complete the installation for this De-
vice: Unknown" appears, click [Specify a location], and then click [Next >].

DWhen the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].

E To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
If Auto Run starts, click [Cancel], and then [Exit].

F Click [Browse].
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G Select the printer driver you want to use.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\

H Click [Open].

I Click [OK].

J Follow the instructions.
When installation is complete, the printer connected to "1394_00n" appears in
the [Printers] window. ("n" shows the number of printers connected.)

Note
❒ If [Found New Hardware Wizard] appears every time the computer is started

or the cable is connected, disable the device. To install another printer driv-
er after setting the "1394_00n" port, click [1394_00] as a port during the
printer driver installation.

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not neces-
sary.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "When You Cannot Print", Trou-
ble Shooting.

Disable the device

If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the device by
following the procedure below.

AWhen the [Found New Hardware Wizard] dialog box appears, click [Next >].

BWhen the message "This wizard will complete the installation for this De-
vice: Unknown" appears, select the [Search for a suitable driver for my device rec-
ommended] check box, and then click [Next >].

CWhen the message "Please choose your search and installation option." ap-
pears, clear all check boxes from [Search for the best driver in these locations.],
and then click [Next >].

DWhen the message "Driver Files Search Results" appears, select the [Disable
the device. The Add/Remove Hardware Wizard in the control Panel can be able to com-
plete the driver installations.] check box, and then click [Finish]."
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Windows XP, Windows Server 2003

Important
❒ SCSI print must be set to "active" from the control panel. For details, see Net-

work Guide.
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ When the printer driver is properly installed, connecting or disconnecting the

optional IEEE 1394 cable causes the printer icon to change.

A Connect the machine and computer using the IEEE 1394 interface cable.
When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

CWhen the message "Please choose your search and installation option." ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

D To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
If Auto Run starts, click [Cancel], and then [Exit].

E Specify the location where the source files of the printer driver is stored,
and then click [Next >].
If the CD-ROM drive is D,  the source files of the printer driver are stored in
the following location:
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\
When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ("n" shows the number of printers connected.)
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F Follow the instructions.

Note
❒ This machine can receive print data from one computer at a time only. If a

job from a computer collides with other data, a message may appear on the
computer.

❒ To install another printer driver after setting the "1394_00n" port, click
[1394_00] as a port during the printer driver installation.

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

❒ Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "When You Cannot Print", Trou-
ble Shooting.

Disable the device

If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the device by
following the procedure below

AWhen the [Found New Hardware Wizard] dialog box appears, check that [This
wizard helps you install software for: Unknown] displayed, select [Install from a list
on specific location (Advanced)] check box, and then click [Next >].

BWhen the message "Please choose your search and installation option." ap-
pears, clear all check boxes from [Search for the best driver in these locations.],
and then click [Next >].

CWhen the message "The wizard could not find the software on your com-
puter for.." appears, click [OK].

DWhen the message "Cannot Install this Hardware" appears, select the [Don't
prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers

can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• Conditions for bidirectional communications
• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.

❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in

the machine.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-

nected via BIP.
• Only JPEG images that can be printed using BIP.
• User codes are disabled for BIP.

You cannot print if print functions are restricted.
• Some printers do not support BIP.
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Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

Important
❒ To install the printer driver under Windows 2000 / XP Professional or Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrator or Power Users group member.

Note
❒ System requirements vary depending on the Bluetooth standard and specifi-

cations. For details, see the manuals provided with each product.
❒ For information about setting up Bluetooth under other operating systems or

using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.

A Start 3Com Bluetooth Connection Manager.

B Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

C On the [Tool] menu, click [COM port].

D Check that the message "Bluetooth Serial Client (COMx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].

F On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

G Click the icon of the printer you want to use.

H On the [File] menu, click [Properties].

I Click the [Ports] tab.

J Under [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

K Click [OK].
Close the [Printers] window.
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If a dialog box appears while transmitting a print job, reestablish network 
connection as follows:

A Select the printer you want to use in the [Printers and Fax] box.

B Click [Connect].

Note
❒ To always use the same printer, select the [Always use for this connection] check box.

Reference
For details, see the manuals provided with the Bluetooth adaptor or com-
puter equipped with Bluetooth.

Configuring Security Mode Settings

A Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.43 “Printing in the Security Mode” 
 For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals provided with the utility.

D Click [OK].
Close the [Security Mode] dialog box.

Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.43 “Printing in the Security Mode”.

Printing in the Security Mode

A Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.

C Enter the Bluetooth password, and then click [OK].
As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the machine.
For example, if the serial number is 00A0-001234, the Bluetooth password is 1234.

D The print job is sent.

Note
❒ The Bluetooth password differs for each machine and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

For Windows 95 / 98 / Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B Double-click the Add Printer icon.

C Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the PostScript 3 printer

driver is either D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1,
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1, or D:\DRIV-
ERS\PS3\NT4\(Language)\DISK1. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a printer].

C Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driv-

er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.

For Windows XP Home Editions:

A On the [Start] menu, click [Control Panel].

B Click [Printers and Other Hardware].

C Click [Printers and Faxes].

D Click [Install Printer].

E Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driv-

er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.
Set up option settings when bidirectional communications are disabled.

Important
❒ Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-

mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Accessories] tab.
Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0, click
the [Device Settings] tab.

E Select options installed from the [Options] area, and then make the neces-
sary settings.
Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0, click
the [Installable Options] area.

F Click [Aplly], and then click [OK] to close the printer properties dialog box.

Reference
For details about making option settings for the printer, see p.65 “Setting
Up Options”.
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Setting Up the Printer Driver

Windows 95 / 98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

E Click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details, see the printer driver Help. 



Setting Up the Printer Driver

47

1

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows 2000 - Accessing the Printer 

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see the printer driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help. 
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Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A  On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C  On the [Preferences] tab, make the necessary settings, and then click [Print]
to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings, log

on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see the printer driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help. 
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Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A  On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C  On the [Preference] tab, make the necessary settings, and then click [Print] to
start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears .

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see the printer driver Help. 

Making printer default settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.
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DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see the printer driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see the printer driver Help. 
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Mac OS
This section explains how to configure a Mac OS to use EtherTalk and USB.
The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details

Important
❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

Note
❒ The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File
It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.
Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [PS Driver] folder.

E Double-click the folder of the language you use.

F Open [Disk1], and then double-click the installer icon.

G Follow the instructions on the screen.

PPD Files

A Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

C Double-click the [Printer Descriptions] folder.

D Double-click the folder of the language you are using.

E Open the [DISK1] folder.
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F Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

G Restart the Mac OS.

Setting Up PPD Files

Important
❒ Make sure that the printers are connected to an AppleTalk network before

performing the following procedure.

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

D Click [Create].

E Click the printer you want to use, and then click [Setup].
A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.56 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.

Setting Up Options

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

D Click [Configure].
A list of options appears.

E Select the option you want to set up, and then select an appropriate setting for it.

F Click [OK].
The list of options closes.

G Click [OK].
The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.
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Installing Adobe Type Manager

Important
❒ Quit all applications currently running before installation. Install ATM after

you restart the computer.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.

C Double-click the CD-ROM drive con.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [ATM] folder.

F Double-click the ATM 4.6.2 installer icon.

G Follow the instructions on the screen.

HWhen the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

I On the [Apple] menu, open [Control Panel], and then click [~ATM].

J The ATM control panel opens.

Note
❒ For details about installation, see the operating instructions in the ATM folder.

Installing Screen fonts
Follow the procedure below to install screen fonts.
The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

C Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [Fonts] folder.

F Double-click the [Screen font] folder.

G Double-click the [TrueType] or [Type1] folder.
Select the font type you want to use.
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H Copy the fonts you want to install in [System Folder].
A confirmation message appears.

I Click [OK].
The fonts are installed.

J Restart the Mac OS.

Changing to EtherTalk
Follow the procedure below to configure to a Mac OS to use EtherTalk.

A Open [Control Panel], and then double-click the AppleTalk icon.

B On the [Connect via:] pop-up menu, click [Ethernet].

C If you change zones, select a name on the [Current zone:] pop-up menu.

D Close the AppleTalk control panel.

E Restart the computer.

Note
❒ The procedures used to configure Mac OS may vary depending on the Mac

OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP

Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk, USB and
TCP/IP.
Follow the procedure below to configure Mac OS X 10.3.8. If you are not using
Mac OS X 10.3.8, see the manual of the Mac OS X you are using for details.

Important
❒ For Mac OS X 10.1 or higher.

Note
❒ The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your network administrator.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS X] folder.

D Double-click the [MacOSX PPD Installer] folder.

E Double-click the installer icon.

F Follow the instructions on the screen.

Setting Up the PPD File

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has "AppleTalk" indicated in the "Connection" column.
If the zone is set, click [More Printers...], and then select the zone from the
second pop-up menu.

❖ Other Mac OS X
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.
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C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, you are using from the [Print Using] popup
menu.
A list of printer types appears.

D Select the PPD file for the model you are using, and then click [Add].

E Quit Printer Setup Utility.

Setting Up Options

A Start System Preferences.

B Click [Print & Fax].

C In the [Printer] list, click the name of the printer you want to use, and then
click [Printer Setup...].

D Select the option you want to set up, and then select an appropriate setting
for it.

E Click [Apply Changes].

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Using USB Interface

Follow the procedure below to set up USB connection.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has "USB" indicated in the "Connection" column.

❖ Other Mac OS X
Click [USB] on the pop-up menu.
The connected printer appears.

C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.
A list of printer types appears.
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D Select the connected printer from the list of printer models, and then click
[Add].

E Quit Printer Setup Utility.

Note
❒ When printing with a USB connection to a Macintosh computer, printer

language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS
X 10.2.3 or higher. Ethernet, wireless LAN and IEEE 1394 (IP over 1394) connec-
tions can also be used.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has "Bonjour" indicated in the "Connection" column.
If the zone is set, click [More Printers...], and then select the zone from the
second pop-up menu.

❖ Other Mac OS X
Click [Rendezvous] on the pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

C Select the name of the connected printer from the list of printer models, and
then click [Add].
Under Mac OS X 10.4 or later, Installable Options window appears. Select the
option you want to set up, and then select an appropriate setting for it, and
then [Continue].

D Quit Printer Setup Utility.

Note
❒ When printing with a Rendezvous connection to a Macintosh computer,

printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-
ing.
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Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your network administrator

A Open [System Preference], and then click the Network icon.

B Click [Built-in Ethernet] in the [Show:] list box.

C Click the [AppleTalk] tab.

D Select the [Make AppleTalk Active] check box.

E To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.

FWhen the settings are made, click [Apple Now].

Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Setting Up Options

To use installed options correctly, first set up the printer driver. If the options are
not recognized, you cannot use them, even though they are physically installed.
The procedure to set up a printer driver varies depending on the operating system.

❖ Windows

Important
❒ If your system is Windows 2000, Windows XP Professional, or Windows

Server 2003, changing printer driver settings requires Manage Printers
permission. Members of Administrators and Power Users groups have
Manage Printers permission by default. When you change printer driver
settings, log on with an account that has Manage Printers permission.

❒ If your system is Windows NT 4.0, changing printer driver settings re-
quires Full Control access permission. Members of Administrators, Server
Operators, Print Operators, and Power Users groups have Full Control
permission by default. When you change printer driver settings, log on
with an account that has Full Control permission.

❒ If you are using Adobe Page Maker 6.0, 6.5, or 7.0 with Windows 95 / 98 /
Me / 2000 / XP, Windows Server 2003, or Windows NT 4.0, you have to
set up options in the Adobe PageMaker's print dialog box.

You can set up any of the options using the following tabs:

Note
❒ To set up options, access the printer driver from Windows. You cannot set

up options if you access the printer driver from an application.

Windows 95 / 98 / Me [Options] on the [Accessories] tab.

Windows 2000 / XP, Windows 
Server 2003

[Installable Options] on the [Device Settings] tab.

Windows NT 4.0 [Installable Options] on the [Device Settings] tab in the 
Properties dialog box.

Mac OS For ethernet, [Chooser] on the Apple Menu. For USB, 
[Change Setup] from the [Printing] menu to open the 
Desktop printer.

Mac OS X [Printer Setup...] in [Print & Fax] to open the System Pref-
erences.
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❖ Mac OS

Important
❒ If you are using Mac OS X, this functions cannot be used.
You can set up all options using the [Chooser] dialog box.

Reference
See p.45 “Making Option Settings for the Printer”, p.56 “Setting Up Options”
or p.60 “Setting Up Options” for the installation method appropriate to your
printing environment.
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Printing a Document

This documentation describes the specific printer functions and menus that are
added by installing the PPD file. For more information about the functions and
menus of the Windows 95 / 98 / Me PostScript printer driver, see the printer
driver's Help.

Important
❒ On a Macintosh, Mac OS 8.6 or higher (Mac OS X Classic environment is sup-

ported.), or Mac OS X 10.1 or higher is required.
❒ If you are using Mac OS X 10.1.x, the following functions cannot be used:

• Sample Print
• Locked Print
• Hold Print
• Stored Print
• Store and Print
• Document Server
• User Code

❒ Applications, such as PageMaker, that have their own drivers do not support
the following functions:
• Sample Print
• Locked Print
• Hold Print
• Stored Print
• Store and Print
• Document Server

Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.
❒ “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the

version, [Features x] is displayed as [Set x] (x is a number). Make adjustments
according to the version you use.
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Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Normal Print
Select this for normal printing. The print job starts immediately after the print
command is given.

Note
❒ Under Windows 95 / 98 / Me, if you want to use an User ID, click the [De-

tails...] button.

❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the machine. The saved job can be printed from the
machine's control panel. You can also delete the saved job.

Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.
❒ Entering the “User ID” helps you distinguish your print job from others.

Reference
For details about how to use Sample Print, see p.70 “How to Use Sample
Print”.

❖ Locked Print
Use this function to save documents in the machine memory with a pass-
word, and then edit and print them as you want.

Note
❒ The “User ID” can contain to eight alphanumeric (a-z, A-Z, 0-9) characters.

The “Password” must be 4-8 digits.
❒ Entering the “User ID” helps you distinguish your print job from others.

Reference
For details about how to use Locked Print, see p.74 “How to Use Locked
Print”.

Windows 95 / 98 / Me [Job Type:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Job Type:] on the [Job Log] tab in the Printing Preferences 
dialog box.

Windows NT 4.0 [Job Type:] on the [Job Log] tab in the Document Defaults 
dialog box.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.
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❖ Hold Print
Use this function to temporarily hold a file in the machine, and print it from
the computer or the machine's control panel later.

Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ Entering the “User ID” helps you distinguish your print job from others.

Reference
For details about how to use Hold Print, see p.79 “How to Use Hold Print”.

❖ Stored Print
Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password” must be 4-8 digits.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID” helps you distinguish your print job from others.

Reference
For details about how to use Stored Print, see p.83 “How to Use Stored
Print/Store and Print”.

❖ Store and Print
Use this function to prints the file at once and also stores the file in the printer.

Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password” must be 4-8 digits.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID” helps you distinguish your print job from others.

Reference
For details about how to use Stored Print, see p.83 “How to Use Stored
Print/Store and Print”.
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❖ Document Server
Use this function to store hard disk documents that you want to print as well
as documents you might want to later combine or process for printing.

Note
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

Reference
For details about the Document Server function, see "Accessing the Docu-
ment Server", Printer Reference.

How to Use Sample Print

Follow the procedure below to print a document using the Sample Print function.

Windows 95 / 98 / Me

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].

C Click the [Setup] tab.

D In the [Job Type:] list, click [Sample Print].

E Click [Details...].

F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters.
The user ID associates the user with his / her jobs.

G Click [OK].

H Click [OK] to close the printer properties dialog box.

I Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.
The sample print job is sent to the machine and one set is printed.

J Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps.
If you want to delete a saved job, see p.74 “Deleting a Sample Print File”.

K On the machine's control panel, press the {Printer} key to display the printer screen.

L Press [Print Jobs].
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M Press [Sample Print Job List].
A list of sample print files stored in the machine appears.
User ID, Date / Time and File Name also appear.

N Select the file you want to print by pressing it.
A list of the print files stored in the machine appears.

O Press [Print] to change the number of sets to be printed.

P Enter the new number of sets using the number keys.
If you do not want to change the set quantity, perform the following step.
You can enter up to 999 sets.
Press {Clear/Stop} to correct any entry mistakes.
When multiple files are selected without setting a quantity, 1 page less than
the minimum number of all settings is applied.

Q Press [Yes].
The remaining sets are printed.

Note
❒ Press [Stop] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ If there is a print job outstanding, this is printed before the sample print job.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Sample Print
jobs by default. If the collate option is selected in the application's [Print] di-
alog box, there may be more prints than required.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the command menu.
If you are using Windows 2000, select the printer, and then perform the following steps.
If you are using Windows XP or Windows Server 2003, select the printer, and
then click [Preferences].

C Click the [Job Log] tab.

D In the [Job Type:] list, click [Sample Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters.
The user ID associates the user with his / her jobs.
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F Click [OK] to close the printer properties dialog box.
If you are using Windows 2000, perform the following steps.

G Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.
The sample print job is sent to the machine, and one set is printed.

H Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.74 “Deleting a Sample Print File”.

I On the machine's control panel, press the {Printer} key to display the printer screen.

J Press [Print Jobs].

K Press [Sample Print Job List].
A list of sample print files stored in the machine appears.
User ID, Date / Time and File Name also appear.

L Select the file you want to print by pressing it.
A list of print files stored in the machine appears.

M Press [Print] to change the number of sets to be printed.

N Enter the new number of sets using the number keys.
If you do not want to change the set quantity, perform the following steps.
You can enter up to 999 sets.
Press {Clear/Stop} to correct any entry mistakes.
When multiple files are selected without setting a quantity, 1 page less than
the minimum number of all settings is applied.

O Press [Yes].
The remaining sets are printed.

Note
❒ Press [Stop] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ If there is a print job outstanding, this will be printed before the sample

print job.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Sample Print
jobs by default. If the collate option is selected in the application's [Print] di-
alog box, there may be more prints than required.
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Mac OS / Mac OS X

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Set the number of copies to two or more.
The sample print job is sent to the machine, and one set is printed.

C In the pop-up menu, click [Job Log].

D On the [Job Type:] pop-up menu, select [Sample Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters.
The user ID associates the user with his / her jobs.

F Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.74 “Deleting a Sample Print File”.

G On the machine's control panel, press the {Printer} key to display the printer screen.

H Press [Print Jobs].

I Press [Sample Print Job List].
A list of sample print files stored in the machine appears.
User ID, Date / Time and File Name also appear.

J Select the file you want to print by pressing it.
A list of print files stored in the machine appears.

K Press [Print] to change the number of sets to be printed.

L Enter the new number of sets using the number keys.
If you do not want to change the set quantity, perform the following steps.
You can enter up to 999 sets.
Press {Clear/Stop} to correct any entry mistakes.
When multiple files are selected without setting a quantity, 1 page less than
the minimum number of all settings is applied.

M Press [Yes].
The remaining sets are printed.

Note
❒ Press [Stop] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ If there is a print job outstanding, this is printed before the sample print job.
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Deleting a Sample Print File

If a printed document is not as required, you can delete the Sample Print file.

A On the machine's control panel, press the {Printer} key to display the printer screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Stored Print Job List].
A list of sample print files stored in the machine appears.

D Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted jobs again.
Only one file can be selected at a time.

E Press [Delete].
A confirmation screen appears.

F Press [Yes] to delete the file.
After the file is deleted the printer screen reappears.
Press [No] to cancel the delete request.

How to Use Locked Print

Follow the procedure below to print a document using the Locked Print function.

Windows 95 / 98 / Me

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B Select the printer, and then click [Properties].

C Click the [Setup] tab.

D In the [Job Type:] list, click [Locked Print].

E Click [Details...].

F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
The user ID associates the user with his / her jobs.

G Click [OK].

H Click [OK] to close the printer properties dialog box.
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I After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.78 “Deleting a Locked Print File”.

J On the machine's control panel, press the {Printer} key to display the printer screen.

K Press [Print Jobs].
A list of print files stored in the machine appears.

L Press [Locked Print Job List].
A list of locked print files stored in the machine appears.
User ID, Date / Time and File Name also appear.

M Select the file you want to print by pressing it.

N Press [Print].
The password screen appears.

O Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
When multiple print files are selected, the machine prints only files that cor-
respond to the entered password. The number of files is displayed on the con-
firmation screen.

P Press [Yes].
A locked file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Locked Print
jobs by default. If the collate option is selected in the application's [Print] di-
alog box, there may be more prints than required.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.
If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.
If you are using Windows XP or Windows Server 2003, select the printer, and
then click [Preferences].

C Click the [Job Log] tab.

D In the [Job Type:] list, click [Locked Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
The user ID associates user with his / her jobs.

F Click [OK] to close the printer properties dialog box.
If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.78 “Deleting a Locked Print File”.

H On the machine's control panel, press the {Printer} key to display the printer screen.

I Press [Print Jobs].
A list of print files stored in the machine appears.

J Press [Locked Print Job List].
A list of locked print files stored in the machine appears.
User ID, Date / Time and File Name also appear.

K Select the file you want to print by pressing it.

L Press [Print].
The password screen appears.
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M Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
When multiple print files are selected, the machine prints only files that cor-
respond to the entered password. The number of files is displayed on the con-
firmation screen.

N Press [Yes].
The locked file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Locked Print
jobs by default. If the collate option is selected in the application's [Print] di-
alog box, there may be more prints than required.

Mac OS / Mac OS X

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Locked Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
The user ID associates the user with his / her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.78 “Deleting a Locked Print File”.

F On the machine's control panel, press the {Printer} key to display the printer screen.

G Press [Print Jobs].
A list of print files stored in the machine appears.

H Press [Locked Print Job List].
A list of locked print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
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I Select the file you want to print by pressing it.

J Press [Print].
The password screen appears.

K Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
When multiple print files are selected, the machine prints only files that cor-
respond to the entered password. The number of files is displayed on the con-
firmation screen.

L Press [Yes].
The locked file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.

Deleting a Locked Print File

If a printed document is not as required, you can delete the Locked Print file.

A On the machine's control panel, press the {Printer} key to display the printer screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Locked Print Job List].
A list of locked print files stored in the machine appears.

D Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.
Only one file can be selected at a time.

E Press [Delete].
A password screen appears.

F Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will reappear if the password was entered incorrectly.
Press [OK] to enter the password again.
When multiple files are selected, the machine deletes only files that corre-
spond to the entered password. The number of files to be deleted is displayed
on the confirmation screen.
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G Press [Yes].
After the file is deleted, the printer screen reappears.

Note
❒ Press [No] to cancel the delete request.

How to Use Hold Print

Follow the procedure below to print a document using the Hold Print function.

Windows 95 / 98 / Me

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].

C Click the [Setup] tab.

D In the [Job Type:] list, click [Hold Print].

E Click [Details...].

F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters. File Name can also be set.
The user ID associates the user with his / her jobs.

G Click [OK].

H Click [OK] to close the printer properties dialog box.

I After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.82 “Deleting a Hold Print  File”.

J On the machine's control panel, press the {Printer} key to display the printer screen.

K Press [Print Jobs].
A list of the print files stored in the machine appears.

L Press [Hold Print Job List].
A list of hold print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

M Select the file you want to print by pressing it.
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N Press [Print].
A confirmation screen appears.

O Press [Yes].
The hold print file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ When printing is finished, the stored file is deleted.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Hold Print
jobs by default. If a collate option is selected from the application's Print di-
alog box, there may be more prints than required.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.
If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.
If you are using Windows XP or Windows Server 2003, select the printer, and
then click [Preferences].

C Click the [Job Log] tab.

D In the [Job Type:] list, click [Hold Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters. File Name can also be set.
The user ID associates the user with his / her jobs.

F Click [OK] to close the printer properties dialog box.
If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.82 “Deleting a Hold Print  File”.

H On the machine's control panel, press the {Printer} key to display the printer screen.
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I Press [Print Jobs].
A list of print files stored in the machine appears.

J Press [Hold Print Job List].
A list of hold print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

K Select the file you want to print by pressing it.

L Press [Print].
A confirmation screen appears.

M Press [Yes].
The hold print file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ When printing finishes, the stored file is deleted.
❒ If the application has a collate option, make sure it is not selected before

sending a print job. The printer driver automatically collates Hold Print
files by default. If a collate option is selected from the application's Print
dialog box, there may be more prints than required.

Mac OS / Mac OS X

A From an application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Hold Print].

D In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters. File Name can also be set.
The user ID associates the user with his / her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.82 “Deleting a Hold Print  File”.

F On the machine's control panel, press the {Printer} key to display the printer screen.
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G Press [Print Jobs].
A list of print files stored in the machine appears.

H Press [Hold Print Job List].
A list of hold print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

I Select the file you want to print by pressing it.

J Press [Print].
A confirmation screen appears.

K Press [Yes].
The hold print file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ When printing is completed, the stored file is deleted.

Deleting a Hold Print  File

If a printed document is not as required, you can delete the Hold Print file.

A On the machine's control panel, press the {Printer} key to display the printer screen.

B Press [Print Jobs].
A list of the print files stored in the machine appears.

C Press [Hold Print Job List].
A list of Hold Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete by pressing it.

E Press [Delete].
A confirmation screen appears.

F Press [Yes].
After the file is deleted, the printer screen reappears.

Note
❒ Press [No] to cancel the delete request.
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How to Use Stored Print/Store and Print

Follow the procedure below to print a document using the Stored Print function.

Windows 95 / 98 / Me

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].

C Click the [Setup] tab.

D In the [Job Type:] list, click [Stored Print] or [Store and Print].
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Print]

Prints the file at once and also stores the file in the printer.

E Click [Details...].

F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
File Name can also be set.
The user ID associates the user with his / her jobs.
You can assign a password to a saved document, but password assignment is
not mandatory.
The same password must be entered when printing or deleting.

G Click [OK].

H Click [OK] to close the printer properties dialog box.

I After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Stored Print File”.

J On the machine's control panel, press the {Printer} key to display the printer screen.

K Press [Print Jobs].
A list of print files stored in the machine appears.

L Press [Stored Print Job List].
A list of stored print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.
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M Select the file you want to print by pressing it.

N Press [Print].
A confirmation screen appears.
If you have already set a password, proceed to the following step.

O Enter a password using the number keys on the password screen, and then
press [OK]
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
If you have not set the password, proceed to the following step.

P Press [Yes].
The stored print file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ The Stored Print files sent to the machine are not deleted unless you delete

them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.87 “Deleting a Stored Print File”.

If the application has a collate option, make sure it is not selected before send-
ing a print job. The printer driver collates the Stored Print files by default. If
a collate option is selected from the application's Print dialog box, there may
be more prints than required.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.
If you are using Windows 2000, select the printer, and then perform the fol-
lowing steps.
If you are using Windows XP or Windows Server 2003, select the printer, and
then click [Preferences].

C Click the [Job Log] tab.

D In the [Job Type:] list, click [Stored Print] or [Store and Print].
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Print]

Prints the file at once and also stores the file in the printer.
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E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
File Name can also be set.
The user ID associates the user with his / her job.
You can assign a password to a saved document, but password assignment is
not mandatory.
The same password must be entered when printing or deleting.

F Click [OK] to close the printer properties dialog box.
If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Stored Print File”.

H On the machine's control panel, press the {Printer} key to display the printer screen.

I Press [Print Jobs].
A list of print files stored in the machine appears.

J Press [Stored Print Job List].
A list of stored print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

K Select the file you want to print by pressing it.

L Press [Print].
A confirmation screen appears.
If you have already set a password, proceed to the following step.

M Enter a password using the number keys on the password screen, and then
press [OK]
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
If you have not set the password, proceed to the following step.
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N Press [Yes].
The stored file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ Stored Print files sent to the machine are not deleted unless you delete

them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.87 “Deleting a Stored Print File”.

❒ If the application has a collate option, make sure it is not selected before
sending a print job. The printer driver automatically collate Stored Print
files by default. If a collate option is selected from the application's Print
dialog box, there may be more prints than required.

Mac OS / Mac OS X

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Print]

Prints the file at once and also stores the file in the printer.

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
File Name can also be set.
The user ID associates the user with his / her jobs.
You can assign a password to a saved document, but password assignment is
not mandatory.
The password must be entered when printing or deleting.

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Stored Print File”.

F On the machine's control panel, press the {Printer} key to display the printer screen.

G Press [Print Jobs].
A list of print files stored in the machine appears.
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H Press [Stored Print Job List].
A list of stored print files stored in the machine appears.
User ID, Date / Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

I Select the file you want to print by pressing it.

J Press [Print].
A confirmation screen appears.
If you have already set a password, proceed to the following step.

K Enter a password using the number keys on the password screen, and then
press [OK]
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
If you have not set the password, proceed to the following step.

L Press [Yes].
The stored file is printed.

Note
❒ Press [Stop] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,

the file is deleted.
❒ Stored Print files sent to the machine is not deleted unless you delete them

in the machine or select [Auto Delete Stored Print Jobs] (see "System", Printer
Reference). For details, see p.87 “Deleting a Stored Print File”.

Deleting a Stored Print File

If a printed document is not as required, you can delete the stored print file.

A On the machine's control panel, press the {Printer} key to display the printer screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Stored Print Job List].
A list of stored print files stored in the machine appears.

D Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.

E Press [Delete].
A confirmation screen appears.
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F Press [Yes].
After the file is deleted, the printer screen reappears.

Note
❒ Press [No] to cancel the delete request.
❒ If you have already set a password in the printer driver, enter it to delete.

How to Use Document Server

Follow the procedure below to print a document using the Document Server function.

Important
❒ An optional hard disk drive is required to use the Document Server function.

Windows 95 / 98 / Me

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B Select the printer, and then click [Properties].

C Click the [Setup] tab.

D In the [Job Type:] list, click [Document Server].

E Click [Details...].

F Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

G Click [OK].

H Start the printing from the application's [Print] dialog box.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the com-
mand menu.
If you are using Windows 2000, select the printer, and then perform the following steps.
If you are using Windows XP or Windows Server 2003, select the printer, and
then click [Preferences].

C Click the [Job Log] tab.

D In the [Job Type:] list, click [Document Server].
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E Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

F Click [OK].
If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.

Mac OS / Mac OS X

Important
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Document Server].

D Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

E Start the printing from the application's [Print] dialog box.

User Code
Use this to set a user code for print logging.
Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.
The following table shows the tabs or menus where you can select this function.

Reference
For details about using SmartDeviceMonitor for Admin, see Help.

Windows 95 / 98 / Me [User Code] on the [Statistics] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[User ID:] on the [Job Log] tab in the Printing Preferences 
dialog box.

Windows NT 4.0 [User ID:] on the [Job Log] tab in the Document Defaults 
dialog box.

Mac OS Select the [Enable User Code] check box, and then enter a 
user code in the [User Code] box on [Job Log] in the print 
dialog box.

Mac OS X Select the [Enable User Code] check box, and then enter a 
user code in the [User Code] box on [Job Log] in the print 
dialog box.
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Paper Selection

All Pages and Destination Tabs

Use this to select the media type and input tray.

Important
❒ This function is for Windows 95 / 98 / Me only.

Reference
For details about the [All Pages] and [Destination] tabs. See the printer driver's Help.

Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the paper sizes supported by this machine, see General Set-
ting Guide.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print
according to paper size.

Windows 95 / 98 / Me [Size:] on the [Paper] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Paper Size:] on [Paper/Output] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document De-
faults dialog box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dia-
log box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

Windows 95 / 98 / Me [Fit to Print Size:] on the [Paper] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Fit to Print Size:] on [Printer Features] on [Document Options] 
on [Advanced...] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

Windows NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

Mac OS [Fit to Paper:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Fit to Paper:] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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❖ Prompt User
Print is performed with the size of document to be printed unchanged.

❖ Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces the
print size.
If the paper size is larger than the size of document to be printed, print is not
to fit the paper size.

❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.

Input Slot

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the paper sources, see Printer Reference.

Resolution

Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.

Reference
For more information about the resolution types, see Printer Reference.

Windows 95 / 98 / Me [Input Tray:] on the [Paper] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Paper Source] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

Windows NT 4.0 [Paper Source] on the [Page Setup] tab in the Document 
Defaults dialog box.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Windows 95 / 98 / Me [Resolution] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Resolution] on [Graphic] on the [Paper/Quality] or [Layout] 
tab in the Printing Preferences dialog box.

Windows NT 4.0 [Graphic] on the [Advanced] tab in the Document Defaults 
dialog box.

Mac OS [Resolution] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Resolution] on the [Features x] tab on [Printer Features] in 
the print dialog box.



Using PostScript 3

92

3

Orientation Override

Use this to set the paper orientation.
The following table shows the tabs or menus where you can select this function.

You can select the following items:
• Off
• Landscape
• Portrait

Gradation

Use this to select a type of gradation based on your purpose.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the gradation types, see Printer Reference.

Windows 95 / 98 / Me [Orientation:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Orientation Override] on [Printer Features] on [Advanced...] 
on the [Paper/Quality] tab in the Printing Preferences dia-
log box.

Windows NT 4.0 [Orientation Override] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Orientation Override] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Orientation Override] on the [Features x] tab on [Printer Fea-
tures] in the print dialog box.

Windows 95 / 98 / Me [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Printer Features] on [Advanced...] on the [Paper/Quality] tab 
in the Printing Preferences dialog box.

Windows NT 4.0 [Document Options] on the [Advanced] tab in the Document 
Defaults dialog box.

Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Toner Saving / Level Color

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Reference
For details about this function, see Printer Reference.

Duplex Printing

Use this function to select duplex printing.

Important
❒ To use this function, the optional duplex unit must be installed on the ma-

chine.
The following table shows the tabs or menus where you can select this function.

The following items may vary depending on the operating system you are using.

Windows 95 / 98 / Me [Toner Saving] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Toner Saving] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Toner Saving] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog 
box.

Mac OS [Toner Saving] on [Printer Specific Options] in the print dia-
log box.

Mac OS X [Toner Saving] on the [Features x] tab on [Printer Features] in 
the print dialog box.

Windows 95 / 98 / Me [Duplex:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Print on Both Sides] on the [Layout] tab in the Printing 
Preferences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab 
in the Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X • 10.3 or higher
The [Two Sided Printing] check box on [Layout] in the 
print dialog box.

• Other Mac OS X
The [Print on both Sides] check box on [Duplex] in the 
print dialog box.
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Windows 95 / 98 / Me

❖ Off
Disables Duplex Printing.

❖ Open to Left
Prints output so that you can open it to the left.

❖ Open to Top
Prints output so that you can open it to the top.

Windows 2000 / XP, Windows Server 2003, Mac OS

❖ None
Disables Duplex Printing.

❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.

❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.

Note
❒ If you are using a Mac OS, click to select the button that means “Flip on Long

Edge” or “Flip on Short Edge”.

Windows NT 4.0

❖ None
Disables Duplex Printing.

❖ Short Side
Prints output so that you can open it to the short edge when bound along the
short edge.

❖ Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.
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Mac OS X

The following functions are selectable under Mac OS X 10.3 or higher (for Mac OS
X 10.2 or earlier, see p.94 “Windows 2000 / XP, Windows Server 2003, Mac OS”):

❖ Off
Disables Duplex Printing.

❖ Long-Edge Binding
Prints output so that you can open it to the long edge when bound along the
long edge.

❖ Short-Edge Binding
Prints output so that you can open it to the short edge when bound along the
short edge.

Collate
Use this function to enable collation. With this feature, the machine can efficient-
ly print collated sets of multiple-page documents.

Important
❒ To use this function, a memory unit of at least 192 MB or hard disk drive must

be installed on the machine.
❒ If you are using Windows 2000, Windows XP, Mac OS or Mac OS X, make

sure that the following check boxes have not been selected.
• Windows 2000

The [Collate] check box on [Printer Features] on [Advanced...] on the [Paper/
Quality] tab in the Printing Preferences dialog box.

• Windows XP
The [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/ Qual-
ity] tab in the Printing Preferences dialog box.

• Mac OS
The [Collate] check box in the print dialog box.

• Mac OS X
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Collate:]on the [Setup] tab.

Windows 2000, Windows XP [Collate:] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Collate:] on [Printer Features] on [Document Options] on the 
[Advanced] tab in the Document Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Collate:] on the [Feature 1] tab on [Printer Feature] in the 
printer dialog box.
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Paper Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the media type supported by this machine, see General Set-
ting Guide.

Destination Tray

Use this to select the destination tray.
The following table shows where you can select this function.

Reference
For details about the destination tray supported by this machine, see \Gener-
al Setting Guide.

Windows 95 / 98 / Me [Type:] on the [Paper] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Media:] on the [Paper/Quality] tab in the Printing Prefer-
ence dialog box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document De-
faults dialog box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Paper Type] on the [Features x] tab on [Printer Features] in 
the print dialog box.

Windows 95 / 98 / Me [Output Tray:] in the [Paper] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Destination] in [Printer Features] on [Advanced...] on the [Pa-
per/Quality] or [Layout] tab.

Windows NT 4.0 [Destination] in [Printer Features] on [Document Options] on 
the [Advanced] tab.

Mac OS [Destination] in [Printer Specific Options] in the print dialog 
box.

Mac OS X [Destination]on the [Features x] tab in [Printer Features] in 
the print dialog box.
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Staple

Use this function to staple sheets of printed paper together.

Important
❒ When stapling, use the finisher option. See General Setting Guide or Printer

Reference.
The following table shows where you can select this function.

Note
❒ The stapling location might differ depending on the orientation of the ma-

chine set in the printer and the orientation of the data to be printed. For de-
tails, see Printer Reference.

Punch

Use this function to punch holes in the printed documents.

Important
❒ When punching holes, use the finisher option. See Printer Reference.
The following table shows where you can select this function.

Note
❒ Punch positions and the number of punch holes that are available will change

depending on the type of finisher, the original's orientation, and the printing
paper size and orientation. For details, see Printer Reference.

Windows 95 / 98 / Me [Staple:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Staple:] in [Printer Features] on [Advanced...] on the [Pa-
per/Quality] or [Layout] tab.

Windows NT 4.0 [Staple:] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Staple:] in [Printer Specific Options] in the print dialog box.

Mac OS X [Staple:] on the [Features x] tab in [Printer Features] in the 
print dialog box.

Windows 95 / 98 / Me [Punch:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Punch:] in [Printer Features] on [Advanced...] on the [Pa-
per/Quality] or [Layout] tab.

Windows NT 4.0 [Punch:] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Punch:] in [Printer Specific Options] in the print dialog box.

Mac OS X [Punch:] on the [Features x] tab in[Printer Features] in the 
print dialog box.
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Z-fold

Use this function to select the Z-fold type in the printed documents.

Important
❒ When Z-fold, use the finisher option. See Printer Reference.
The following table shows where you can select this function.

Watermark

Set the Watermark function.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Text

Select the Watermark Text type.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 95/98/Me [Z-fold] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Z-fold] in [Printer Features] on [Advanced...] on the [Pa-
per/Quality] or [Layout] tab.

Windows NT 4.0 [Z-fold] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Z-fold] in [Printer Specific Options] in the print dialog box.

Mac OS X [Z-Fold] on the [Features x] tab in[Printer Features] in the 
print dialog box.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark:] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] or [Layout] tab in the Printing Preferences 
dialog box.

Windows NT 4.0 [Watermark:] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark Text:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Text:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.
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Watermark Font
Select the Watermark Font type.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Size
Select the Watermark Size size.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Angle
Select the Watermark angle.

Important
❒ This item is only for portrait, not for landscape.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark Font:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Font:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark Size:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Size:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark Angle:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Angle:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.
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Watermark Style
Select the Watermark style.

Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS

X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Color Mode
Use this to select whether the document is printed in color or black and white.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Color
Prints color documents in full color.

Note
❒ Color images will be printed using CMYK toner, Cyan, Magenta, Yellow

and Black. CMYK are three primary subtractive colors.
❒ If you want to adjust the print color, adjust the settings in the Advanced

dialog box accessed from the Advanced button on the [Paper/Quality] tab.

❖ Black and White
Prints everything, including color documents, in black and white. Black and
White printing is faster than Color printing. To stop black and white areas be-
ing printed with CMYK toner, select [Black and White] in the printer driver as
well as in the application.

Note
❒ If you use Windows 95/98/Me, this mode is called “Color/ Black and

White:”.

Windows 2000 / XP, Windows Serv-
er 2003

[Watermark Style:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Watermark Style:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Windows 95/98/Me [Color/ Black and White:] on the [Setup] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Color Mode] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Mode] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Color Mode] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Mode] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Color Setting

Use this to select the correction method used for color conversion.

Important
❒ If you use Windows 95/98/Me, you can configure [Color Setting:] in [Ad-

vanced] by selecting [Manual] from the [Color] setting. [Automatic] sets the print-
er to “Super Fine”.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Off
No modification to the color setting.

❖ Fine
Select this setting to perform color matching based on one of the printer's
built- in color rendering dictionaries and perform CMYK conversion. This
setting performs the printing which output target is Monitor γ = 1.8.

❖ Super Fine
Select this setting to use a color rendering dictionary as in the “Fine” setting but
produce output that is more vivid. Use this setting to emphasize light colors.
This setting performs the printing which output target is Monitor γ = 2.2.

Note
❒ The color rendering dictionary that is selected in the “Color Profile” setting is used.
❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to

color matching, so you should select the appropriate CRD for the document
you are printing. The selected CRD is also referred to when [Fine] or [Super
Fine] is selected for “Color Setting:”. The following items are available: [Au-
to],[Photographic], [Presentation] and [Solid Color].

Windows 95/98/Me [Color Setting:] on the [Advanced]window displayed when 
clicking [Advanced...] after selecting [Manual] on [Color] on 
the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Color Setting:] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Setting:] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Color Setting:] on [Printer Specific Options] in the print dia-
log box.

Mac OS X [Color Setting:] on the [Features x] tab on [Printer Features] 
in the print dialog box.
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Color Profile
Use this to select the color profile pattern.

Important
❒ If you use Windows 95/98/Me, you can configure [Color Profile:] in [Advanced] by

selecting [Manual] from the[Color] setting. [Automatic] sets the printer to “Auto”.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Auto
Use this setting to configure the best color profile pattern automatically de-
pending on the appearance of the document to be printed.

❖ Photographic
Use this setting to enhance the reproduction of photos and graphics that in-
clude midtones.

❖ Presentation
Use this setting to enhance the reproduction of documents that contain text
and graphics. This CRD is best for printing colored charts, graphs, presenta-
tion materials and so on. If you use this CRD for printing photographs, the
color or gradations might not be reproduced well.

❖ Solid Color
Use this setting to print specific colors, logos and so on.

❖ User Setting
Use this setting to print images with downloaded CRD from your application.

❖ CLP Simulation1
Use this setting to print blue color more brightly and vividly.

❖ CLP Simulation2
Use this setting to print blue color more brightly and vividly. Print results are
lighter than those of CLP Simulation1.

Windows 95/98/Me [Color Profile:] in the [Advanced]dialog box displayed 
when you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Color Profile] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Profile] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Color Profile] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Note
❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to

color matching, so you should select the appropriate CRD for the document
you are printing. The selected CRD is also referred to when [Fine] or [Super
Fine] is selected for “Color Setting:”. The following items are available: [Au-
to],[Photographic], [Presentation] and [Solid Color].

Black Over Print

Select whether or not to apply a black color over any other colors when printing.
The following table shows the tabs or menus where you can select this function.

Gray Reproduction

Use this to select the Black Color mode for text and line art.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Black by K
Prints using black toner

Windows 95/98/Me [Black Over Print] in [Advanced] by selecting [Manual] from 
the [Color] setting.

Windows 2000 / XP, Windows Serv-
er 2003

[Black Over Print] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Black Over Print] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Black Over Print] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Black Over Print] on the [Features x] tab on [Printer Features] 
in the print dialog box.

Windows 95/98/Me [Gray Reproduction (Text/Line Art):] in [Advanced] by select-
ing [Manual] from the [Color] setting. [Automatic] sets the 
printer to “Pure Black Text”.

Windows 2000 / XP, Windows Serv-
er 2003

[Gray Reproduction (Text/Line Art):] on [Printer Features] on 
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Gray Reproduction (Text/Line Art):] on [Printer Features] on 
[Document Options] on the [Advanced] tab in the Document 
Defaults dialog box.

Mac OS [Gray Reproduction (Text/Line Art):] on [Printer Specific Op-
tions] in the print dialog box.

Mac OS X [Gray Reproduction (Text/Line Art):] on the [Features x] tab on 
[Printer Features] in the print dialog box.
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❖ Black/Gray by K
Prints black using gray.

❖ CMY + K
Prints using all toner colors.

❖ Black/Gray by K (Text only)
Prints black text in gray.

❖ Black by K (Text only)
Prints text using black toner.

Dithering

Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Auto
Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

❖ Photographic
Performs dithering using an appropriate pattern for photographs.

❖ Text
Performs dithering using an appropriate pattern for text.

❖ User Setting
Use this setting to print images set in half tone in your application.

Windows 95 / 98 / Me [Dithering:] in the [Advanced]dialog box displayed when 
you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Dithering:] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] or [Layout] tab in the Printing Preferences di-
alog box.

Windows NT 4.0 [Dithering:] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Dithering:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Dithering:] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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CMYK Simulation Profile
You can simulate the color tone of the printing ink.
You can select the printing ink from US OffsetPrint, Euroscale and JapanColor.

Image Smoothing
Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.

❖ Off
Disables image smoothing.

❖ On
Performs image smoothing unconditionally.

❖ Auto
Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

Windows 95/98/Me [CMYK Simulation Profile:] in the [Advanced]dialog box dis-
played when you click [Advanced...], after selecting [Man-
ual] from [Color] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[CMYK Simulation Profile:] on [Printer Features] on [Ad-
vanced...] on the [Paper/Quality] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [CMYK Simulation Profile:] on [Printer Features] on [Document 
Options] on the [Advanced] tab in the Document Defaults 
dialog box.

Mac OS [CMYK Simulation Profile:] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [CMYK Simulation Profile:] on the [Features x] tab on [Printer 
Features] in the print dialog box.

Windows 95 / 98 / Me [Image Smoothing:] in the [Advanced]dialog box displayed 
when you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Image Smoothing:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] or [Layout]tab in the Printing Preferenc-
es dialog box.

Windows NT 4.0 [Image Smoothing:] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Image Smoothing:] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Image Smoothing:] on the [Features x] tab on [Printer Fea-
tures] in the print dialog box.
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❖ Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

Note
❒ When [Auto] is selected, data processing may take a long time.
❒ When Image Smoothing: is used for a mask image, this function may have an

undesired effect on the print result.

Separate into CMYK
Use this to select the print separation type.
You can separate the printing data into CMYK to specify a specific color combination.

Color Control
Use this to select whether or not you want the colors in the documents to be adjusted
before printing so that the printed page matches closer to the colors on the screen.
The following table shows the tabs or menus where you can select this function.

❖ Image Color Control
Display the Image Color Matching dialog box, click this button to specify ex-
actly how you want the colors on your screen adjusted before printing.

Note
❒ If you use Windows 2000 / XP or Windows Server 2003, this function is called

“Image Color Management”.
❒ If you use Windows NT 4.0, this function can not be configured.
❒ If you use Mac OS, this function is called “Color Matching”.

Windows 95/98/Me [Separate into CMYK:] in the [Advanced]dialog box dis-
played when you click [Advanced...], after selecting [Man-
ual] from [Color] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Separate into CMYK:] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Separate into CMYK:] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Separate into CMYK:] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Separate into CMYK:] on the [Features x] tab on [Printer Fea-
tures] in the print dialog box.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Graphic] on [Advanced] on the [Paper/Quality] tab in the 
Printing Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Color] on the [Color Matching] tab in the print dialog box.

Mac OS X This function is not available.
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By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Important
❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-

ity for Mac.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

A Start the Mac OS.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

C Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS] folder.
Under Mac OS X, double-click the [Mac OS X] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Print-
er Utility for Mac] file, and then drop it into the Macintosh hard disk.

F Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Dri-

vers and Utilities”.
❒ Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic 

environment is supported.)
❒ Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Mac OS

Important
❒ Before starting Printer Utility for Mac, make sure the printer is selected in

[Chooser] on the Apple menu.

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].
Printer Utility for Mac will take a few seconds to start.

Mac OS X

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].

C In the [Available Printers:] box, select the printer you want to use.
If you change zones, select a name from [Available Network Zones:].
Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

D Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

E Click [Choose].
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖ File menu
• [Download PS Fonts...]

Download fonts (PostScript Type 1) to the printer. See p.110 “Download-
ing PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See p.110 “Displaying Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.111 “Initializing the Printer
Disk”.

• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.112 “Page Setup”.

• [Print Fonts Catalog...]
Print the names of available fonts. See p.112 “Printing Fonts Catalog”.

• [Print Fonts Sample...]
Print a sample of fonts. See p.112 “Printing Fonts Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.112 “Renam-
ing the Printer”.

• [Restart Printer]
Restart the printer. See p.113 “Restarting the Printer”.

❖ Utility menu
• [Download PostScript File...]

Download a PostScript file. See p.114 “Downloading PostScript Files”.
• [Select Zone...]

Change the zone to which the printer belongs to via Appletalk. See p.114
“Selecting the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.115 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See
p.115 “Launching the Dialogue Console”.
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important
❒ The following procedures to download the fonts assume that you are a system

administrator. If you are not, be sure to consult your system administrator.
❒ If the printer restarts, all the printer settings return to their defaults.
❒ Confirm that a Mac OS and the printer are connected with Appletalk.
❒ During the download, do not turn off the power switch, operate the panel or

open or close the cover.

A Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

C Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

D After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

E Click [Download].
The fonts begin to download, and the download status is shown.

FWhen the completion message appears, click [OK].

G Click [Cancel].

Note
❒ Some fonts cannot be downloaded.
❒ Before downloading, read the documentation about the fonts you want to use.

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.

A Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Click [OK].

Note
❒ The fonts displayed in italics are the default fonts.
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Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

Important
❒ You cannot delete the fonts displayed in italic.

A Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Select the fonts you want to delete.

D Click [Delete].
A confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

F Click [Continue], and then click [OK].

G Click [OK].

Initializing the Printer Disk

When initializing the printer's hard disk drive, all the fonts downloaded to the
printer's hard disk drive are deleted. Before initializing, be sure to check the
fonts on the hard disk drive.

Important
❒ When initializing the printer's hard disk drive from the operation panel, all of

the data on the printer's hard disk drive is deleted. Before initializing, be sure
to check the data on the hard disk drive.

❒ Do not turn off the power switch until initializing is completed, otherwise the
hard disk drive might be damaged.

A Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.
To cancel initialization, click [Cancel].

B Click [Execute].
Initializing starts.

CWhen the completion message appears, click [OK].



Printer Utility for Mac

112

4

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

A Select [Page Setup...] on the [File] menu.

B Choose the paper size.

Printing Fonts Catalog

Print the names of fonts available on the printer.

A Select [Print Fonts Catalogue] on the [File] menu.

B Click [Print].

Note
❒ The paper selected under [Page Setup] is used.

Printing Fonts Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

A Select [Print Fonts Sample...] on the [File] menu.

B Click [Print].

Note
❒ Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

Important
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.
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Mac OS

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G Select the printer whose name you changed, and then close the [Chooser] di-
alog box.
If there are several Appletalk zones, select the zone the machine belongs to.

Mac OS X

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone for the Macintosh in use.

G In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.

A Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.
The fonts that you downloaded in the printer's memory will be deleted.
If the printer restarts, all the printer settings return to their defaults.
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Downloading PostScript Files

You can download a Postscript file to the printer.

A Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to download and click the file name, and then click
[Open].

C Type the log file name, and then click [Save...].
The selected file is downloaded.
Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important
❒ Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone in which you want to locate the printer, and then click
[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G In the [Appletalk zone:] list, select the zone you changed.

H In the [Select a PostScript Printer:] list, select the printer you want to use.

I Close the [Chooser] dialog box.
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Mac OS X

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone which you want to locate the printer in, and then click
[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone you changed.

G In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

B Confirm the current status of the printer.
You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs to.

C Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

Important
❒ “Launch Dialogue Console” is recommended for users with an understand-

ing of PostScript.
❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.
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B Type the PostScript command in the editor screen.
To edit a PostScript file, select [Open] on the [File] menu to open it.
You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.
The PostScript file is sent to the printer.
The [Reply from Printer] box opens, depending on the PostScript file you sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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